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STEM Sims
Student Tracking Instructions

Welcome to STEM Sims! The following directions are for using the Student Tracking feature of STEM Sims.

A. General Teacher Account Information

Please note: STEM Sims with Student Tracking consists of multiple accounts: 1) Your teacher account, 2) a
generic student login account that all students use to sign into STEM Sims, and 3) personal individual student
accounts that provides access for each student to enter and submit work.

1) Teacher Account Access
We provided you with a Teacher Account username and password. Please change this password immediately
and keep this password and username secure from others.

' 8 e.g. 8-12 characters

2) Generic Student Account Access
We provided you with a Generic Student Account username and password. This generic login is used by all
students. The password does not need to be changed; however, you can change the password if you desire.

l A e.g. jsmith students

3) Individual Student Account Access

The Individual Student Accounts are created when you first create a Class name (Section B) and then add
Students to a given class list (Section C). The students will select their name from a class list and when they
first sign in to STEM Sims, each student will be asked to create a private password. If your students forget their
password, you can allow them to reset their password from the Teacher Account dashboard.

‘ Ae.g mary b. l 6 e.g. 8-12 characters




B. Creating a New Class
1) To create a New Class, select the Classes tab on the STEM Sims homepage.
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2) Select the “Create Class” button
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Active Student Classes

Period 1 Spring 2021 View Edit Archive Remove

Period 2 2020 2021 View Edit Archive Remove

Create Class

3) Enter the name of your Class, select the Year and Academic semester. Then click the “Create” button.

Create Class

Please enter the name of the class you would like to create

Class Name [ Period 3 ]
Academic Year [ 2021 B ]
Academic Semester [Full Year 3]

Create

4) The Class Name can be changed at any time using the Edit button on the Active Student Classes page.



C. Entering Student Names into a Class
1) First open a Class from the Active Student Classes page by selecting the View tab.

Active Student Classes

Period 1 Spring 2021 it Archive Remove
Period 2 2021 View Edit Archive Remove

Period 3 2021-2022 View Edit Archive Remove
2) Enter the Student Name and then select the Add Student button to continue.

Period 1 Spring Class

Bob B Reset Password Records Edit Move Remove
Patti L Reset Password Records Edit Move Remove
RicL Reset Password Records Edit Move Remove

Reset Password Records Edit Move Remove

Add StUdent +

3) Continue adding all students in a given Class.
4) When done, select the Return to Class button.

D. Viewing Student Records

You can view the following in the Student Records section: A Student’s Assessment Results, Lesson Question
Answers, and/or the Entire Laboratory Report with Lesson Questions.

1) To view a given Student’s Records, first choose the Student’s Class by selecting the View tab on the Active
Student Classes page.

Active Student Classes

Period 1 Spring 2021 it Archive Remove

Period 2 2021 View Edit Archive Remove

Period 3 2021-2022 View Edit Archive Remove

2) Next, select the Records tab for the student work you would like to review.



Period 1 Spring Class

Bob B
Patti L
RicL

Sterling P

Reset Password Records Edit Move
Reset Password Edit Move
Reset Passwo it Move
Reset Password  Record Edit Move

Remove

Remove

Remove

Remove

3) Ric L.’s Records opens to his Assessment Results. In this case, he has completed two Assessments, one on
Erosion Control, and another one on Dronopter.

View Ric L's Records

Assessments

Simulation Name
Erosion Control

Dronopter

4) Selecting the Lesson Questions button at the top of the page moves you to his responses to the Lesson

Lesson Questions Lesson Table

Grade Time Taken @ Date Submitted
62.5% (5/8) 25.00 secs 2021-2-4 19:52:52
87.5% (7/8) 59.00 secs 2021-2-4 19:53:58

Questions. By selecting the Lesson Name, his responses to the Lesson Questions may be viewed.

View Ric L's Records

Assessments

Lesson Table

Lesson Questions

Simulation Name Lesson Number Time Taken @ Date Submitted
Erosion Control 1 1.68 mins 2021-2-419:59:17
Dronopter 1 1.57 mins 2021-2-4 20:1:4
. . '
View Ric L's Records

Simulation Name
Erosion Control
Question Number
1
2

3

Dronopter

Lesson Number Time Taken @ Date Submitted
1 1.68 mins 2021-2-4 19:59:17
Submission

The steeper the slope, the greater the distance traveled by the eroded material.
Steep slopes may lead to much soil erosion.

Add a retaining wall or make the slope less steep.

1 1.57 mins 2021-2-4 20:1:4



5) Selecting the Lesson Table button at the top of the page moves to his responses to the full laboratory,
including his data and calculations. His entire laboratory work can be viewed by selecting the View Submission
tab for a given lesson.

View Ric L's Records

Assessments Lesson Questions Lesson Table

Simulation Name Lesson Number Time Taken @ Date Submitted
Erosion Control 1 1.68 mins 2021-2-419:59:17
Dronopter 1 1.57 mins 2021-2-4 20:1:4 View Sapmission

E. Editing, Moving, or Permanently Removing a Student from a Class
i) Editing a Student Name
You can change the name of a student at any time by completing the following steps.

1) Select the student’s class from the Active Student Classes Page.
2) For the given student, select the Edit tab at the right side of the page.

3) Enter the correction/modification to the student’s name and then select the Edit button.

Period 1 Spring Class

Bob B Reset Password Rece Remove
Patti L Reset Password  Records a Move Remove

Ric L Reset Password Records Edit Move Remove

Sterling P Reset Password Records Edit Move Remove

Add Student 4



ii) Moving a Student to a Different Class

You can move a student from one class to another or move the student to an Inactive Students class.

1) Select the student’s class from the Active Student Classes Page.
2) For the given student, select the Move tab from the right side of the screen.

3) Select the Destination menu and choose the class you want to move the student.

Period 1 Spring Class

Bob B Reset Password
Patti L Reset Password
RicL Reset Password
Sterling P Reset Password

iii) Permanently Removing a Student from the Class

Records

Records

Records

Records

Edit “™MOVE Remove

Edit Move Remove

Edit Move Remove

Add Student 4

Important note: This action will permanently delete this student and all records from the class. This action
cannot be undone! If you want to save this student’s information in case the student returns at a later date,
create a new class (called Inactive) and move the student to this class. Complete the following steps to

permanently remove a Student from a Class.
1) Select the student’s class from the Student Classes Page.
2) For the given student, select the Remove tab at the right side of the page.

3) Check that the proper student’s name is listed and then select the Remove button.

Period 1 Spring Class

Bob B Reset Password
Patti L Reset Password
RicL Reset Password
Sterling P Reset Password

Records

Records

Records

Records

Edit Move Remove

Bomaano
Remove

Edit Move Kemove

Edit Move

Edit Mo

Add Student ==



F. Resetting an Individual Student’s Account Password
To allow a student who forgot her/his password to reset the password, complete the following steps.

1) Select the student’s class from the Active Student Classes Page.

2) For the given student, select the Reset Password tab at the right side of the page.

Period 2 Class

Bob M. ‘ ords Edit Remove

Add Student 4+

Return to Class List Class Records

3) Check that the proper student’s name is listed and then select the Reset Password button. The next time the
student tries to login to STEM Sims, the student will be prompted to create a new password.

Reset Student Password

Resetting a student password will require the student to create a new password.

Are you sure you want to reset the password for Bob M.?

Reset Password

G) Archiving a Class

You can archive a Class and all student records for a given Class. This action should only be done at the
conclusion of an academic class. An archived class’s students cannot complete and/or submit any work, but
their data and records will be saved for later viewing. NOTE: This action cannot be undone.

1) To Archive a class, select the Archive tab from the Active Student Classes page.

Active Student Classes

Period 1 Spring 2021 View

Period 2 2021 View

Period 3 2021-2022 View

2) Make sure to carefully read the warning and select the Archive button only at the conclusion of an academic
class.



Archive Class Period 2

Class Name  Period 2

This action should only be done at the conclusion of the class. Once archived, no additional student work can be completed in this class. You will only be able to retrieve and view any
student record once the class is archived. Do you want to Archive this class?

Archive Cancel

H) Modifying Background, Methods, or Assessment Access

You can change the access to various parts of STEM Sims for all of your classes. Since some teachers want to
use STEM Sims as a pure inquiry experience, the Methods tab that provides directions for conducting the
simulation may be disabled. The Background and Assessment tabs may also be disabled either individually or
collectively.

1) To change access, select the Account tab from the menu at the top of the screen.

—
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Active Student Classes

Period 1 Spring 2021 View Edit Archive Remove
Period 2 2021 View Edit Archive Remove
Period 3 2021-2022 View Edit Archive Remove

2) Select the Student Options tab on the right side of the screen.

Information Password Subscription Student Options

3) Toggle any of the Page Access buttons on the right side of the screen to modify access to any of the three
sections: Background, Methods, or Assessment. This action can be changed at any time. NOTE: All of your
classes will have the same access that you selected.

Information Password Subscription Student Options

Reset Password Page Access
Reset the password for the student account (that all of your students use). Limit access to certain sections of the simulation page for all of your students.
Current Teacher Password [ Current Password ] Access to Background section O
New Student Password [ New Password l Access to Methods section O
Confirm Student Password [ confirm Password l Access to Assessment section 0

Change Password
Save Access Changes



I) Translating STEM Sims into Other Languages
STEM Sims may be translated into more than 100 different languages.

1) Select the Google Translate® drop-down menu from the upper right-hand corner of the screen to select the
desired language.

About Simulations Search By.. Classes @ Pricing

Simulations

Training

Select Language B Powered by Go-gle Translate

Most Popular

Dronopter @

J) Using the “Planning and Carrying Out Investigations” Feature

An optional feature of STEM Sims is the ability of having students complete a pre-lab section on how they
would plan and carry out their investigation. This feature also has the students predict their results. To access

this feature, open the Challenge page. Select the “Planning and Carrying Out Investigations link from the
middle of the page.

&% Planning and Carrying Out Investigations @

Acceleration Brochure

Once here, students should read each question enter their answers in the box provided. When complete, students
should select the Submit button at the bottom of the page.

Predict

What do you think will be the outcome of your investigation?

Why do you think this will be the outcome of your investigation?

To review student responses, select the Class tab and go to the students’ specific class and view their records.

View Ric L's Records

Assessments Lesson Questions Lesson Table ‘ Planning Questions ’

Simulation Name Time Taken @

9



STEM Sims Student Use Instructions

K. Generic Student Account Login Instructions
All students will sign into their STEM Sims accounts by completing the following steps.

1) Select the Login button from the top right-hand side of the screen.
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2) Enter the generic username and password provided by the teacher.

—

(S}
Sign Up About Simulations Search By.. @EED@ Pricing Training Help Log In
Amnoe

You need to login to access that page.

Log in to STEM Sims

Username [ bostonteacher student ]

Password [ """ ]

LogIn

3) Select the Log in button.

L. Individual Student Account Login Instructions
1) Once they login using the generic account credentials, students will select their class from the Select a Class
list.

10



Select a Class

Please select your class from the list below.

Period 1 Spring
Period 2

Period 3

2) Next, students will select their names from the Class list.

Select a Student

Please select your name from the list below.

Bob B
Patti L
Ric L

Sterling P

3) The first time students enter STEM Sims, they will be asked to create passwords that only they know and use
for accessing their individual accounts. Once the student enters the password correctly twice, select the Create
button to continue.

Create Password for Sterling P

Student Name Sterling P

Password 1 ‘

Confirm Password ‘ v ‘

Create

4) Once they select or enter their password after the initial sign in, the student will use this password to submit
all work to the teacher. For information on resetting passwords that students forget, please refer to Section F of
this guide.

LogintoRicL

Student Name RicL

Password | e t

LogIn

11



5) Once individually logged in, students can submit their Assessments and Laboratory data and Lesson
Question answers completed online to their teacher by selecting the Submit button at the end of the documents.

FIU 1ransimission

1. Which of the following is the most effective method of preventing the spread of the flu?

A handwashing
8. wearing masks
C. sanitizing surfaces
D. antibiotics
2. How is the flu treated?
A with vaccines
8. with antibiotics
C.with antiviral medicines
D. the flu cannot be treated

3.Which of the following s not a typical symptom of the flu?
A headaches
8. chills
€.a sore throat
D. fainting
4. The fluis:
A a respiratory illness.
8.an inherited condition.
€. an infection of open wounds.
0. 2 bacteria that causes food poisoning.

5. The best way to avoid contracting the flu is to get a flu vaccine.
Atrue
8.false

6. Antiviral medicine:

A. helps prevent flu infections.

B. reduces the severity of symptoms and the length of time you are sick
€. should not be taken by people with chronic illnesses such as diabetes.
D. should not be taken often because side effects are common.

7.The fl P fected person toa y person through small droplets when the infected person sneezes or coughs.
Atrue
8. false

8. Methods of preventing the spread of flu include all of the following except:

A. sanitizing common surfaces.

8. coughing into your elbow instead of your hands.
C. washing your hands after you blow your nose.
D. sharing food and drinks.
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